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INTRODUCTION 

This guide describes how to setup a home or small business network using a file server based around Windows 8.1. 

Windows 8.1 is a great choice in such environments as it offers the everyday ease and convenience of Windows, but 

without the additional cost and complexity of Windows Server or the unfamiliarity of Network Attached Storage (NAS) 

boxes. This guide is succinct but authoritative, based around techniques that work in the real world and is written in a 

friendly and understandable style, along with plenty of illustrations and screenshots. It is aimed at the home, home 

office or small business user who has some knowledge and experience but who would not necessarily consider 

themselves to be an expert or enthusiast. It has been written according to the Goldilocks Principle: not too much 

information, not too little information, but just the right amount. 

Chapter 1 – Getting Started – describes the benefits of networking, makes the case for using Windows 8.1 as a server 

and covers hardware, software and infrastructure considerations. Chapter 2 covers the detailed installation of 

Windows 8.1 and the necessary settings for successful networking. Chapters 3 and 4 describe how to setup users and 

shared folders, whilst Chapter 5 reviews the different methods for accessing the server from connected computers. 

Chapter 6 discusses multimedia and streaming – a common use for a home network. Chapters 7 and 8 look at Cloud 

services such as Dropbox and Google Drive and what is involved in using iPads and other portable devices. Chapter 9 

is concerned with the important topic of backups. Chapter 10 looks at what is involved in keeping the server in a 

healthy state and Chapter 11 describes how to access it remotely. 

Some notes about this book: 

 Most references are explicitly to Windows 8.1, but there may be some instances where the term ‘Windows 8’ 

is used interchangeably.  

 Screenshots for connected computers reflect a mixture of Windows 8 and Windows 7 as these are the most 

widely used clients; any differences in their behaviours are described.  

 Spellings use a mixture of International and American English and should hopefully be acceptable and 

understandable to most readers. 
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1 GETTING STARTED 

1.1 The Benefits of a Server-based Network 

Home and small business computer networks come in two basic types: peer-to-peer and centralized. In a peer-to-peer 

network, any or all of the computers may store the shared data. In this example there are five computers in a small 

organization, with the accounts on one machine, the supplier details on another, the customer list on a third and so 

on: 

 

Figure 1: Peer-to-peer network 

The computers have been configured so that they can connect to each other to access data as required. For instance, 

if Linda wants to check the orders she connects to Mike’s laptop, or if Steve wants a copy of the latest marketing 

presentation he connects to Lucy’s PC. This method of working was developed when the company consisted of just 

two people and has grown with it. In the early stages it was satisfactory, but with time has become increasingly 

problematic. For instance, Mike is often out of the office and takes his laptop with him. When this happens nobody 

can access the latest order status; to try and work around it the others have taken to keeping copies of the orders file 

on their own computers, but this leads to confusion over which is the most up-to-date version. Additionally, Aaron has 

put a power-on password on his computer as a security measure and if he is late into the office no-one can access the 

data on his computer. Recently, the company had to hire a temporary worker after one of the team went on extended 

leave; it proved very problematic trying to get them to understand where everything was stored. 

Such peer-to-peer arrangements were the norm in households and in small businesses a decade ago and can still work 

well in some very small environments, but quickly become untenable as the number of computers and users rises. At 

such a point a centralized network becomes a much more practical method of working. Here all the data is held on a 

single, dedicated machine – known as a server or file server. This is not used as a general purpose computer and may 

not even have a mouse, keyboard and screen. Rather, it acts as a repository of all of the data, whether that is business 

information or the sort of data that may be found in a typical household, such as photos, music and videos. Being a 

dedicated machine it is always there and there are single master copies of the most important files. Crucially, the 

contorted methods of working dictated by a peer-to-peer network are avoided. 
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Figure 2: Centralized (server based) network 

Besides the benefits of data always being accessible and in a known place, it becomes much easier to back it up and 

to administer things. Compare the links between the computers as shown in the two diagrams above then imagine 

the implications if another 3 or 4 machines were added in each case: the first example becomes nightmarish but the 

second remains straightforward and understandable. 
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1.2 The Case for Windows 8.1 as a Server 

Once the decision has been taken to use a server, there are several possible solutions. Microsoft have a full server 

product – Windows Server 2012 R2 – that can cater for any business from the smallest up to the largest of enterprises 

comprising tens of thousands of users. It is a great product but has the following possible downsides: 

 It is not aimed at home users 

 It is relatively expensive for small systems 

 It requires that the connected computers run the more expensive, Professional editions of Windows. Small 

businesses often purchase their computers from high street and other retail outlets and they are usually 

supplied with the Home edition of Windows, which does not connect to Windows Server 2012 R2 

 It is more complicated to setup and maintain than regular Windows, requiring skills and experience that people 

who do not work in IT do not usually have 

Another solution is to use Network Attached Storage (NAS). A NAS drive is an external hard drive, but it connects 

through an Ethernet cable to a router rather than to a single PC using an USB cable, thus making it shareable. NAS 

drives can be relatively cheap and are a good solution in many situations, but have the following downsides: 

 They use proprietary operating systems and methods of working that are unfamiliar to many people 

 There may be limited access to expertise available in the event of difficulties  

 There are many brands to choose from, some from unfamiliar companies, making the market confusing and 

giving the risk of investing in “the wrong one” 

Both of the above alternatives suffer from the problem that they are just not “regular Windows”. Many people are 

familiar with Windows through experience and by using it they can operate within their comfort zone. In recognition 

of this, Microsoft actually launched a dedicated “home server” version some years ago. It was not successful for a 

variety of reasons, but many of the pioneering features subsequently made their way into standard versions of 

Windows (most notably a feature called Storages Spaces in Windows 8.1 is derived from the highly regarded Drive 

Extender of Windows Home Server Version 1). 

Using Windows 8.1 as a server does involve some compromises. In particular, it is not suitable for larger setups. A 

typical use might be in a household, a home business or a small business or organization with up to say, an absolute 

maximum of 10 computers. However, the combination of prices, features and familiarity do make it an attractive 

proposition in such scenarios.  
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1.3 Hardware Considerations for the Server 

When it comes to the server there are four basic possibilities: 

Standard desktop computer with Windows pre-installed - Desktop computers that have Windows pre-installed are 

readily available from retail and other outlets. They represent the easiest and often cheapest option for creating a 

Windows 8.1 server and are suitable for use in home, home office and very small business networks (say up half-a-

dozen users). The following factors should be considered: 

 It should preferably be a desktop computer. Laptop computers are unsuitable whilst all-in-one computers with 

built-in screens have no additional benefits 

 It does not need to be particularly powerful. The most important requirement is that it has plenty of disk 

storage e.g. 1TB, 2TB or better 

 It should be running Windows 8.1 

Standard desktop computer with Windows purchased separately - Computers that do not come with a copy of 

Windows are available, usually from smaller retailers, suppliers and mail order. They are often more customizable; for 

instance, a unit with plenty of spare drive bays can be purchased or one that allows the user to add their own, 

separately purchased hard drives. This approach often appeals to enthusiasts. The copy of Windows 8.1 will need to 

be purchased separately, either retail or possibly as a so-called OEM edition with the hardware. 

Build your own – This approach often appeals to enthusiasts although computers are made with such standardised 

components these days that putting one together is well within the capabilities of many people. Doing so may or may 

not save any money, but it will provide a great deal of flexibility. For instance, if you wanted a tiny, totally silent server 

you could use something like a Gigabyte Brix or Intel NUC with a solid state drive (SSD). Alternatively, you may wish 

for a conventional tower unit with multiple drive bays, capable of providing many terabytes of storage. Some 

considerations: 

 The processor does not need to be particularly powerful 

 In most circumstances, 4GB RAM will be sufficient 

 It is possible to purchase hard drives that have been optimized for server use, offering greater reliability and 

MTBF (Mean Time Between Failures). Examples include Western Digital Red and Seagate NAS lines 

 Windows 8.1 can be installed on a relatively small SSD (64GB will be sufficient) with conventional hard drives 

used for the main data storage 

 RAID is not required as the Storage Spaces feature provides similar functionality 

Micro Server - One consideration with a standard desktop PC is that it is not really designed for 24x7 operation. In 

contrast, there is a category of computer specifically designed for use as a server and which is intended to be more 

reliable and better able to cope with the demands of continuous operation. Such servers are more expensive than 

regular PCs, usually more so than a small business can justify. However, it is possible to purchase relatively low cost 

but still full-featured and reliable micro servers, specifically aimed at smaller organizations. As their name suggests, 

these servers are smaller than usual. They also tend to use less energy, which is useful for a device that is never 

powered off. Examples of micro servers include the HP ProLiant MicroServer and the Dell T20. In a small business 

setting, the use of a micro server is recommended. 

1.4 Editions of Windows 8.1 

Windows 8.1 comes in a variety of editions: Windows 8.1; Windows 8.1 Professional; Windows 8.1 Enterprise. In 

practice there is very little difference between them – the Professional and Enterprise editions have a few more tweaks 

and features to assist with their usage in corporate environments, but nothing which will unduly affect what we are 

trying to achieve here, with the possible exception of remote access. If you purchase a computer from a retail outlet 

then it will probably have the standard or home version of Windows 8.1 already installed on it. If you have a choice or 

are buying a copy of Windows 8.1 to install on a computer then it is suggested you go for the Professional version. 
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If you are using a computer that is running the original version of Windows 8, you should first update it to Windows 

8.1. The upgrade is free from the Windows Store. Some people have reported problems trying to download and install 

it; if you experience this, make sure that all previous updates have been applied first and keep trying. 
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1.5 Infrastructure 

The term infrastructure is used here to describe the physical network, basically the boxes and wires that connect 

everything together and to the outside world. In a home or small business system, a device called a combined wireless 

router is commonly used. This connects to the internet, which may be a cable, fiber or ADSL service, directly or possibly 

via a separate box (usually referred to, albeit incorrectly, as a modem). It has wireless capabilities for linking laptops, 

tablets and smartphones. There will be several Ethernet ports, used for connected wired devices such as desktop PCs. 

The server needs to be wired directly to one of these ports. There may, optionally, be a wireless extender or switch to 

extend the network to other parts of the premises. 

The above description is generic but should bear some resemblance to your infrastructure. Some key points are: 

 The server PC should be connected to the main network switch or combined wireless router using an Ethernet 

cable. 

 Use wired connections whenever possible as performance is so much better than wireless. Wired devices 

should be of Gigabit specification. 

 For wireless devices such as laptops and tablets, make sure they operate at 801.11n or 801.11ac specification. 

 Check the specification of the combined wireless router if you are using one. Many ISPs (Internet Service 

Providers) supply relatively low-cost models, often free of charge when you sign-up with them. These are often 

of average quality, for instance the Ethernet ports may not be Gigabit or the latest wireless standards may not 

be supported. Spending money on professional or prosumer (“professional consumer”) routers and switches 

will usually give better performance and reliability. 
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Figure 3: Typical Home/Small Business Infrastructure 

1.6 Location 

The server should be attached to the network via a Gigabit Ethernet connection, preferably by plugging it directly into 

the router. Do not connect it wirelessly. It should be placed away from direct sunlight and any source of heat, such as 

a radiator. Avoid locations that are wet or damp. As little physical access is required the unit can be located out of 

sight and reach, for instance in a cupboard or a locked room or otherwise out of reach. 

1.7 Electrical Considerations 

It is possible that data loss and damage can occur if the electrical mains power fails whilst a server is running. The best 

way to mitigate against this is to use an intelligent UPS (Uninterruptible Power Supply) with it; in the event of power 

problems this will enable it to continue operating normally for a short period and then to shut it down in an orderly 

manner if necessary. In a business environment, the use of an UPS should be considered mandatory. Suitable UPS 

units are made by companies such as APC, CyberPower, Powercom. Make sure that any software supplied with it is 

Windows 8-compatible. 
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If an UPS is not used - which is commonly the case in a domestic environment - then the unit should at least be 

connected to a clean electrical power supply via a surge protector.  

1.8 Printers 

An additional advantage of networking is that it allows printers to be shared, thus potentially saving money as well as 

physical space. One rather old fashioned method of sharing a printer is to plug it directly into the server and configure 

it using sharing features built-in to Windows, but it can be difficult to get this working and diagnose when it doesn’t, 

such that it is not even worth bothering with in the first instance. Fortunately, most modern printers have built-in 

Ethernet or wireless connections, giving them an existence on the network totally independent of any server or 

computers and this is by far the best approach.  
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2 INSTALLATION AND CUSTOMIZATION OF WINDOWS 8.1 

Some of the steps vary here depending on whether the server is a standard desktop computer that has been purchased 

with Windows already installed, such as one obtained from a retail outlet, or if it is a micro server or desktop computer 

that has been purchased as a blank machine and on which a legitimately obtained copy of Windows 8.1 will be 

installed. 

2.1 Standard desktop computer with Windows pre-installed 

It is assumed here that this is a brand new, out-of-the-box computer that has never been used before. If this is not the 

case then it should first be reset to that condition: take backups of any data on it then use the ‘Factory restore’ option. 

This procedure varies depending on the vendor: it may an option on the Start Screen; there may be an icon on the 

Desktop; it may be an option when the computer starts up; alternatively launch PC Settings (Windows Key + I) and 

choose Update and Recovery followed by Recovery. After the reset is complete proceed to section 2.3 Personalization 

and Settings. 

2.2 Blank desktop computer or Micro server 

With these computers it will be necessary to install Windows 8.1 from scratch. Usually Windows is purchased in the 

form of a DVD ROM; alternatively, it can be downloaded as an executable from Microsoft and transferred to DVD or 

USB using a separate computer. Once the hardware is ready (e.g. all hard drives connected), insert the media and set 

the computer to boot from DVD or USB as appropriate. This is usually done from the BIOS by pressing a key as the 

computer starts up (e.g. F2, F10, F12 or Escape – it depends upon the vendor). After a short while the following screen 

appears; choose the correct regional settings then click Next: 

 

Figure 4: Specify the regional settings 

On the following screen click Install now then accept the subsequent license agreement: 
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Figure 5: Install now 

On the next screen choose Custom: Install Windows only (advanced): 
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Figure 6: Choose Custom Install 

This is followed by a screen that asks where Windows is to be installed. What appears here depends upon what hard 

drives are in the computer; in this example there is a 1TB (1000 GB) drive so we will choose it. Click Next: 
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Figure 7: Choose the installation drive 

At this point the installation proper begins. This will take a little while, typically 10 or 15 minutes and whilst it runs a 

status screen is displayed. The computer may restart several times during this stage: 
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Figure 8: Installation progress screen 
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2.3 Personalization and Settings 

After the computer restarts the Personalize screen is displayed. Choose a colouring scheme and give the computer a 

name. Unless you have a good reason to do otherwise, call it server, because that is what it is! Click Next:  

 

Figure 9: Personalization screen 

The follow-on screen is entitled Settings. The choice is Express – which is quicker to setup but which benefits them 

(Microsoft) – or Customize, which is a bit slower to setup but which benefits you. Choose Customize: 
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Figure 10: Choose Customize screen 

On the next screen choose Yes. This is very important, as it will cause Windows to configure the most appropriate 

network settings: 



 

21 
 

 

Figure 11: Choose ‘Yes – For home or work networks’ 

On the next screen you want: 

 Windows Update not set up 

 Automatically get device drivers On 

 Automatically update my apps Off 

 SmartScreen online services Off 

 Send a Do Not Track request On. 

Then click Next:  
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Figure 12: Various settings 

On the subsequent screen you want: 

 Use Windows Error Reporting On 

 Use compatibility lists for Internet Explorer Off 

 Send some location data to Microsoft Off 

 Send info to Microsoft about how you use your PC Off 

 Send info to Microsoft about how you use Help to Off 

Then click Next: 
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Figure 13: More settings 

The endless questions continue. Set everything on the next screen to Off. Click Next: 
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Figure 14: Even more settings 

The next screen is one that many people find confusing and misleading as it implies that you need something called a 

Microsoft Account in order to use the computer. This is typically a Hotmail, Windows Live or Outlook email account, 

which many people will have anyway. However, it is not necessary at all and not recommended here:  
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Figure 15: Click ‘Create a new account’ 

Do not enter any details. Instead, click the Create a new account option. This will display a form; do not complete it, 

instead click the Sign in without a Microsoft account option at the bottom of the screen:  

 

 

Figure 16: Click ‘Sign in without a Microsoft account’ 
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The screen that is now shown allows you to create a local account on the computer (i.e. one that is nothing to do with 

Microsoft) which will be used for managing the server. For the User name specify systemadmin.  Enter and re-enter a 

password, along with a hint. The best passwords are non-obvious, not too short and contain a mixture of letters and 

numbers. Do not use words like ‘password’, ‘secret’, ‘admin’ or ‘server’. Then click Finish: 

 

Figure 17: Create the systemadmin account 

There will now be a wait whilst Windows installs a number of apps and generally sets things up, during which time the 

screen color constantly changes and displays messages intended to entertain and inform. Eventually the installation 

will complete and you will be presented with the Desktop or the Start Screen, from where you can access the Desktop. 

Note that you may have more icons and a different coloring scheme to that shown below:  
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Figure 18: Standard Windows Desktop 

If you are using a computer that came with Windows pre-installed on it, chances are, depending on the vendor, that 

it has bloatware on it – unnecessary programs, trials, games and demo’s – that will slow it down and sap resources. 

These need to be removed. The standard way to do this is go into the Control Panel (right-click the Start button) and 

choose Programs and Features. Unfortunately it is a matter of having to know what to look for, although trial versions 

of anti-virus and security programs are an immediate target as they simply duplicate something already built-in to 

Windows 8.1 in the form of Windows Defender. Alternatively, there are utility programs available for download that 

claim to do much of the job for you e.g. look at http://pcdecrapifier.com/download. 

Note: this paragraph applies to computers that do not come with Windows pre-installed on them and if this does not 

apply to you skip to the next section. Windows 8.1 does a very good job of identifying the hardware inside a computer 

and installing appropriate drivers for it. However, in some instances it will fail to do so and in such cases it will be 

necessary to go to the computer manufacturer’s website and locate and download suitable drivers for Windows 8.1 

(this may have to be done from a different PC). In the case of a micro server, they may not be listed under Windows 

8.1, in which case ones for Windows Server 2012 R2 will usually be suitable. It may not be strictly necessary to 

download every driver, for instance, sound is not really needed on a server. The most important ones are: the network 

(Ethernet) driver; general chipset support (which will be from Intel or AMD); video graphics; anything pertaining to 

SATA. 
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2.4 Windows Product Key and Activation 

Depending on the version of Windows 8.1 you have – but certainly with retail versions – you may be prompted to 

enter a product or license key at some stage. This may occur early on during the installation process or after you have 

completed the installation and been running the system for a little while. The product key is usually located on a sticker 

that came with the Windows 8.1 packaging, stuck on the side of the computer or in an email if you purchased and 

downloaded your copy online. 

2.5 Windows Updates 

It is important to check for and apply the updates to Windows that Microsoft makes available on a regular basis. Such 

updates may provide improved or additional functionality, but more typically address security issues that could 

potentially compromise the system. On regular desktop and laptop computers, Windows updates are often applied 

automatically; however, it is suggested that automatic Windows updates are not enabled on a computer used as a 

server. The reason for this is to ensure control over the process and prevent the risk of the server rebooting on its own 

accord following an update. Also, in a business environment it is suggested that updating is done out of hours so as to 

avoid any disruption to service, perhaps on a monthly basis. 

Go into Control Panel. If it is currently set to view by Category, change it to view by Large Icons. Click the  Windows 

Update icon followed by the Turn on Automatic updates button, which will force the system to check for updates. 

After a couple of minutes the screen will refresh and display a message that “nn important updates are available” 

(where nn is the number of such updates). Click the message and on the next screen click the Install button at the 

bottom of the screen. The updates will download and install; this may take some time and may necessitate the server 

having to restart to complete the process. 

Once the server is up-to-date, go back into Windows Update and click Change Settings. Set it to a value other than 

‘Install updates automatically’ and click OK.  

 

Figure 19: Windows Update settings 
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2.6 Power Management 

Windows 8.1 has power management features to help reduce power consumption, for instance by putting the 

computer to sleep or in hibernation mode when it has not been used for any length of time. Whilst useful on a laptop, 

such features are less so on a computer being used as a server. For instance, if the server has gone to sleep you do not 

want the delay and inconvenience of having to wait until it starts up again when you want to save or retrieve a file – 

you expect it to be instantly available. For this reason, the power management features in Windows 8.1 need to be 

adjusted. 

To do this go into Control Panel. Make sure the view is large icons and click Power Options to display the following 

panel (note that there may be some minor variations to the following screenshots depending upon the brand of 

computer): 

 

Figure 20: Power options 

A selection of power plans are listed; we want High performance (if it is not listed click Show addition plans). Against 

High performance click Change plan settings. The key attribute is Put the computer to sleep, which should be set to 

Never: 
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Figure 21: High performance power plan 

Returning to the main Power Options panel, click Choose what the power buttons do. Your choices here depend on 

your local circumstances; if you are the only person that uses the server then you may not want to bother about this 

panel too much. But if, for example, the server is being used in a small business environment and is readily accessible 

by other people then you may choose to disable the power buttons plus insist on a password as below: 



 

31 
 

 

Figure 22: Power Options, System settings 
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2.7 Network Settings 

The next step is to change network settings on the server, such that users can share folders and resources. There are 

three types of networking available in Windows 8.1: Domain, HomeGroup and Workgroup. Domain networking refers 

to corporate networking, where a Windows 8.1 Professional client connects to a server running a variant of the 

Windows Server operating system, such as Windows Server 2012 R2. This is not applicable here. HomeGroup is a 

simplified form of networking that was first introduced with Windows 7. It certainly has some merits, but also some 

limitations plus it only works for Windows 7 and Windows 8 computers. Workgroup networking can be thought of as 

a more flexible, universal approach, which can also handle other versions of Windows, Apple Macs, tablets and other 

devices, so this is the solution we will use. 

Launch the Control Panel and choose Network and Sharing Center. Click Change advanced sharing settings. The 

settings required are as follows: 

 Under Network discovery you want Turn on network discovery and Turn on automatic setup of network 

connected devices 

 Under File and printer sharing, Turn on file and printer sharing 

 Under Homegroup connections, Use user accounts and passwords to connect to other computers 

 

Figure 23: Advanced sharing settings 

Having made the changes, click Save changes. 
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2.8 Disk Storage 

Most desktop and laptop computers have one physical hard drive, configured as a single volume and commonly 

referred to as ‘the C: drive’, upon which everything is stored. However, in a server there are often several disks or 

volumes to provide greater amounts of storage and improve reliability. It is also good practice to store Windows on a 

separate volume to the data. Why? Should there ever be a need to reinstall or upgrade Windows then it is possible to 

do so without affecting the data. It is also easier to manage and backup the data. 

If you are using a computer with a single hard drive, you can achieve some of this by dividing it into two volumes and 

how to do so is described in the section below. If you are using a computer with multiple hard drives you should make 

use of Windows 10’s Storage Spaces feature as described in section 2.10 Storage Spaces (Multiple Drive System) 

instead. 

2.9 Storage in a Single Drive System 

Right-click Start and launch File Explorer. Right-click This PC and choose Manage from the pop-up menu. Click on Disk 

Management to display this screen: 

 

Figure 24: Disk Management screen 

Right-click the C: drive and choose Shrink Volume. After a few seconds a panel appears advising by how much you can 

shrink C: in order to make some space for what will become our data volume. It defaults to the maximum permissible 

value, meaning you could choose to shrink by a smaller amount but not by a larger amount, although in practice you 

would normally accept what is being proposed by just clicking the Shrink button: 
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Figure 25: Shrinking a volume 

It may take a few moments to shrink the volume; when complete you will be returned to the main screen. Right-click 

on the Unallocated area which has appeared and choose New Simple Volume: 

 

Figure 26: Choose New Simple Volume 

The New Simple Volume Wizard will be invoked. Click Next on the first two panels. The third one is used for assigning 

a drive letter to the new volume; typically in a single drive system it will propose E: as the new drive, on the basis that 

the main drive is C: and the DVD drive is D:, which is fine. Things could be different on your system, although it doesn’t 

actually matter what the new drive letter is. Click Next: 
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Figure 27: Assigning a drive letter 

On the subsequent panel the defaults are fine, although you may optionally wish to change the Volume label to a 

more meaningful name, such as Data. Click Next: 

 

Figure 28: Format Partition 
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The final panel is just a summary screen – click Finish. The new volume may take a few moments to format and after 

it has done so a notification message will pop-up in the corner of the screen – it can be ignored. Close down the 

Computer Management screen and go to section 3 USERS. 
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2.10 Storage Spaces (System with Multiple Drives) 

Storage Spaces is a feature of Windows 8.1 that allows systems with multiple hard drives to be better utilized and 

managed. It is designed to address three aspects of storage: 

Firstly, on a Windows computer each hard drive normally has a separate drive letter to identify it. For instance, the 

first drive is the C: drive, the second is the D: drive, the third is the E: drive and so on. However, it is more convenient, 

particularly in a network, if drives can be pooled together to appear as a single large volume. This makes it easier to 

find things by removing the requirement to know upon which physical drive a particular file or folder is located: 

 

Figure 29: Storage Pool aggregates the hard drives 

Secondly, Storage Spaces provides a degree of protection against data loss in the event of a drive failing. Multiple 

copies of files are stored on different drives; if a drive fails then a copy from a different one is automatically used. The 

failed drive can then be replaced and added back to the storage pool. This technique is analogous to RAID (Redundant 

Array of Inexpensive Drives), a technology commonly found on corporate file servers, but here it is implemented as a 

software rather than hardware solution. 

Finally, the pool can easily be added to in order to provide more storage space, without excessive disruption or 

reconfiguration. One important thing to note is that the drives can largely be of any type; for instance, external USB 

hard drives can be connected to the computer and added to the storage pool. 

In this example, the computer already had a hard drive, upon which Windows is installed. Two further drives, each of 

2TB have been added; now, Storage Spaces will be used to join them together to create a protected volume.    

Go to Control Panel and click Storage Spaces. Click Create a new pool and storage space (if User Access Control is 

invoked answer Yes). A panel listing the available drives is shown: 
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Figure 30: Select the drives to create a storage pool 

Tick each drive and click the Create pool button. The options which then appear depend upon the number of drives 

being added. If two drives are being used, the options are:  

 Simple - in which the drives are aggregated to create a single large volume (sometimes known as JBOD or 

Just a Bunch of Disks in other computing environments) 

 Two-way mirror – in which data is duplicated on each drive in order to provide redundancy (analogous to 

RAID 1 in other computing environments) 

If three or more drives are being used then two more options become available: 

 Three-way mirror – in which data is triplicated across the drives to provide even more redundancy 

 Parity – here data is stored across all the drives. Additional information (known as parity) is used by the 

system, such that data is preserved in the event of a drive failure (analogous to RAID 5 in other computing 

environments) 

The amount of storage space available depends upon the option selected. In our example, we are using a pair of 2TB 

drives. If these are configured in Simple mode then the total amount of storage is 4TB; if configured in Two-way 

mirror mode then the amount of available storage is 2TB. 

Note that when creating a storage space you can name it and give it a drive designation e.g. E: in this example. This 

drive designation replaces the existing ones and only applies to the server, not to any connected computers.   
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Figure 31: Creating a storage space 

After the Storage Space has been created, a summary screen is displayed. The Storage pool can also be managed 

from this screen: 
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Figure 32: Managing Storage Spaces 
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3 USERS 

In order to access the Windows 8.1 server from another computer, it is necessary to enter the details of an account 

name that exists on the server, along with a password. The use of account names and passwords provides the most 

basic degree of control and management in a networked computer system. 

The user names should first be created on the server and there are several approaches that can be taken here, 

depending on your requirements. The user names can be just about anything you want, although there is considerable 

merit in following a scheme of some sort. Note that the user names on the server do not have to be the same as any 

local accounts that exist on the individual computers. 

For example: 

 In a home network you could use the first names of the family or household members e.g. David, Mary, Mike 

 In a very small business (3-4 people) you could do likewise 

 In a business you could follow a convention of using the first name plus the initial of the surname, or the initial 

of the first name plus the surname, although in some parts of the world other conventions might be more 

appropriate e.g. aarong, nishap, johns, sarahj or agoldberg, npatel, jsmith, sjones 

 Alternatively, in an organization where there is a higher turnover of staff you could use abstract names such 

as user1, user2, user3, user4 and so on  

There are two methods of creating a new user in Windows 8.1. 

3.1 Creating a User with PC Settings  

PC Settings is the modern alternative and eventual replacement to the Control Panel. To invoke it, hold down the 

Windows key in conjunction with the letter I (“aye”). On the bottom right-hand corner of the screen click Change PC 

Settings (alternatively, go the Start Screen, click the downward arrow to view all program and find and launch PC 

Settings from there). On PC Settings, choose Accounts, Other accounts, Add an account, Sign in without a Microsoft 

account, Local account. Specify the user name and password, repeat the password, enter a hint, click Next then Finish. 

3.2 Creating a User from the Command Prompt 

Some people are wary of working using the command prompt, but it is a very efficient way of doing some things. Right-

click the Start button and choose Command Prompt (Admin). You may get a warning from User Account Control – 

click Yes. A command prompt window is displayed. Type: net user username password /add and press Enter, where 

username is the name of the user to be created and password will be their password e.g. net user jsmith secret123 

/add. Whilst the command prompt box is open, create all the remaining users. 

Note that having created the users – regardless of technique – it is not necessary to login to the server to test them or 

customize them in any way, as they will never need to work directly on the server and the act of doing so will create 

some extraneous files. In fact, it is recommended that you do not do so. 

3.3 Deleting a User from PC Settings 

Should it be necessary to delete a user – for instance, when somebody leaves the organization – it can be done as 

follows. Click Start followed by Settings, else hold down the Windows key in conjunction with the letter I (“aye”). Click 

Accounts, Other Users. Click the user’s name then click Remove button. Acknowledge the warning message about 

data being deleted. 

3.4 Deleting a User from the Command Prompt 

Right-click the Start button and choose Command Prompt (Admin). You may get a warning from User Account Control 

– click Yes. A command prompt window is displayed. Type: net user username /del and press Enter, where username 



 

42 
 

is the name of the user to be deleted. Note that the user is deleted immediately – there is no warning or ‘Are you 

sure?’ type of message. 

 



 

43 
 

4 SHARED FOLDERS 

The main purpose of a network is to provide an environment for users to store and share information. This is done by 

creating folders on the server, some shared and some private, then defining access rights to control who sees what. 

The structure of these folders will depend upon the requirements of the household or organization, but a typical 

starting arrangement might be: 

 A shared documents folder that everyone has access to 

 Shared folders for music, photos and videos (particularly so for a home system)  

 Individual home folders for each user 

4.1 Setting up the Shared Folders 

Using File Explorer navigate to the storage location, which is the E: drive on our system. Create a folder called Shared, 

which can be done by clicking the New Folder icon on the Home tab of the Quick Access Toolbar or Ribbon, or by right-

clicking and choosing New > Folder, or by pressing Shift Ctrl N simultaneously: 

 

Figure 33: Creating a folder 

Having done so, right-click it and choose Share with > Specific people. On the resultant panel click the down-pointing 

chevron (arrow) and click on Everyone followed by the Add button. Everyone will appear in the bottom panel; against 

it is a chevron; click it and change the Permission Level from Read to Read/Write: 
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Figure 34: Specifying permissions for the Shared folder 

Click the Share button. If you receive a message ‘Do you want to turn on network discovery and file sharing for all 

public networks?’ choose No. After a short while a confirmation screen will be shown – click Done. 

Returning to the Shared folder within File Explorer, open it and create four sub-folders within it, called: Documents; 

Music; Pictures; Videos. These are just regular folders and it is not necessary to go into the sharing settings. 

It should now be possible to view the shared folders from another computer on the local network. Go into File 

Explorer/Windows Explorer, expand the Network section and drill-down to the Server > Users section (alternatively 

hold down the Windows and letter R keys simultaneously and enter \\server\shared). Expand the Shared folder and it 

should look something like this (there may be cosmetic variations to this screen depending upon which version of 

Windows you are using): 
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Figure 35: View of shared folders 
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4.2 Home Folders 

It is now necessary to create individual home folders for each user. A home folder is a personal folder for storing work 

on the network that does not need to be shared with other users. It is analogous to the ‘Documents’ or ‘My Documents’ 

folder that each user normally has on their own computer, but with two advantages. Firstly, it can be accessed from 

any computer on the network. Secondly, it will be backed up courtesy of the server (assuming a backup has been setup 

and how to do so is described in section 9.1 Server Backups). 

Begin by creating a new shared folder called Homes on your data drive (in our example it is the E: drive, but it may be 

different on yours). Having done so, right-click it and choose Share with > Specific people. On the resultant panel click 

the down-pointing chevron (arrow) and click on Everyone followed by the Add button. Everyone will appear in the 

bottom panel; against it is a chevron; click it and change the Permission Level from Read to Read/Write: 

 

Figure 36: Specifying permissions for the Shared folder 

Click the Share button. After a short while a confirmation screen will be shown – click Done. 

Within the Homes folder, create individual folders for each user – the names of the folders should correspond exactly 

to the names of the users as created in section 3 USERS.  

The question of security needs to be considered. As things stand, any user can access any other user’s home folder; in 

other words, the folders are personal but they are not private. In a home or very small business setting this might not 

be an issue, in which case you can skip to the next chapter. But if it is then access to the home folders can be controlled 

and this is done as follows: 

Right-click on a particular user’s home folder and choose Share with followed by Specific people. On the panel that 

appears click the chevron on the drop-down (as indicated by large arrow in below illustration), select the user’s own 

name and click Add. Now that they are included, click on Permission Level and change it from ‘Read’ to ‘Read/Write’. 
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Now click on Everyone and change their Permission Level to Remove. Click the Share button. After a few seconds there 

will be a confirmatory message that the folder is now shared – acknowledge it by clicking Done. Repeat this step for 

all the users in turn, so that each user is sharing just their own individual folder: 

 

Figure 37: Specifying the permissions  

You may have spotted that when you right-clicked on a home folder and chose Share with, a list of users was displayed, 

so why did we not just click on a name rather than choose the Specific people option? The reason is that it would have 

made the share Read only, necessitating an additional step to then change the Permission Level to Read/Write just so 

that the user could save files in their own home folder! 
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5 ACCESSING THE SERVER 

There are multiple methods for accessing the server and each approach has its own merits: 

 Method 1 – Using Windows Explorer/File Explorer 

 Method 2 – Accessing a shared folder using the Run command 

 Method 3 – Mapping drives manually 

 Method 4 – Using a batch file 

 Method 5 – Connecting a Mac 

For accessing the server using a portable device such as a tablet, see section 8 USING IPADS AND OTHER PORTABLE 

DEVICES. 

5.1 From Windows Explorer/File Explorer 

The simplest way to access the server from another computer is by going into Windows Explorer (called File Explorer 

in Windows 8, 8.1 and 10). Expand the left-hand panel to view the Network and down the left-hand side the server 

should be visible. Click on it and the list of shared folders will be displayed. Note: you may be prompted to enter a 

valid user name and password as previously defined on the server (if you wish, tick the option box to remember the 

login details, although you should only do this if you are the sole user of the computer) Although many shared folders 

may be visible, you can only access the ones to which you have privileges. Also note that this screen will vary 

cosmetically depending on which version on Windows you are using: 

 

Figure 38: List of folders from Windows Explorer 
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5.2 Accessing a Shared Folder Using the Run Command 

To access a shared folder from a Windows PC click Start then choose Run (in the case of Windows 8.1 right-click the 

Start button then choose Run). Alternatively, hold down the Windows key and press the letter R. In the small dialog 

box that appears, type in the name of the shared folder e.g. \\server\shared and click OK. 

 

Figure 39: Accessing a shared folder 

The contents of the folder will be displayed in Windows Explorer, from where the files can be accessed and used in 

the standard way: 

 

Figure 40: List of shared folders 
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5.3 Mapping Drives Manually 

The techniques considered so far provide access to shared folders by referring to them using what are called UNC or 

Universal Naming Convention names e.g. \\server\shared. However, many people are accustomed to and prefer to 

use drive letters such as C:, D: and so on. The process by which a UNC name can be turned into a drive letter is known 

as mapping and there are several ways to go about, discussed in the following sections.  

Network drives can be mapped manually using Windows Explorer/File Explorer: 

 If using Windows 10 open File Explorer, which usually appears on the Taskbar by default (you can also click 

the Start button and launch it from there). Click on the shared folder to highlight it. On the menu bar click 

Home followed by the Easy Access icon and then Map as drive.  

 If using Windows 8 or Windows 8.1, open File Explorer, which usually appears on the Taskbar by default (in 

Windows 8.1 you can also right-click the Start button and launch it from there). On the menu bar click This PC 

then click the Map network drive icon on the ribbon, followed by Map network drive on the dropdown. 

 If using Windows 7, open Windows Explorer, which usually appears on the Taskbar by default, else click My 

Computer on the Start menu. If the menu bar is not displayed, click Organize > Layout > Menu bar to display 

it. From the Menu bar choose Tools > Map Network Drive.  

 If using Windows Vista, run Windows Explorer by clicking Start > All Programs > Accessories > Windows 

Explorer, else click Computer on the Start menu. If the menu bar is not displayed, click Organize > Layout > 

Menu bar to display it. From the Menu bar choose Tools > Map Network Drive. 

 If using Windows XP, run Windows Explorer by clicking Start > All Programs > Accessories > Windows Explorer, 

else click My Computer on the Start menu. From the menu bar choose Tools > Map Network Drive. 

On the resultant panel choose a drive letter from the drop-down. For the Folder, click on the Browse button and 

navigate through the network to find the server and the desired folder. Or, simpler still, just type in the name of the 

folder: 
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Figure 41: Mapping a drive 

If the computer is only ever used by one person tick the Reconnect at sign-in box – this will cause Windows to 

remember the mapping. Then click Finish. You may be prompted to enter the user’s name and password that were 

defined earlier. If the computer is used just by one person tick the Remember my credentials box. Then click OK. 

 

Figure 42: Entering network credentials 

Upon a successful connection, the contents of the newly mapped drive will be displayed. The process now needs to 

be repeated for each folder that the user needs access to. In the case of the home folder, map to 

\\server\homes\username, where username is the name of the user e.g. \\server\homes\louiseb  

Note that you can use whatever drive letters you wish, as long as they are not already in use (for instance you cannot 

use C as that is always in use on the local computer). However, using sensible letters makes things easier. For example, 

map music to M, pictures to P and videos to V. Here are some suggested mappings: 

Drive Folder 

H \\server\homes\username 

M \\server\shared\music 

P \\server\shared\pictures 

S \\server\shared 

V \\server\shared\videos 
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5.4 Using a Batch File 

Setting up a batch file is a more advanced technique for use on Windows PCs but can be useful when a computer is 

used by more than one person; as such it is probably of more relevance in a small business environment than in a 

home system. Start off by using Notepad or WordPad to create a plain text file called Connect-to-Server. The contents 

of the file will vary depending on the folders to be mapped; in this example the four shared folders we created plus 

the user’s personal home folders are mapped. Note: this file can also be downloaded from the Windows 8 section of 

the www.serverinstallationguides.co.uk website. 

@echo off 

ping server -n 1 > nul 

if errorlevel 1 goto offline 

:online 

: remove any drive mappings already present 

net use * /delete /y > nul 

: prompt for server username and password 

set /p sname=Enter Username: %=% 

set /p spwd=Enter Password: %=% 

: map the drives 

net use h: \\server\homes\%sname% %spwd% /persistent:no /USER:%sname% 

net use m: \\server\shared\music /persistent:no 

net use p: \\server\shared\pictures /persistent:no  

net use s: \\server\shared\documents /persistent:no 

net use v: \\server\shared\videos /persistent:no 

goto end 

:offline 

cls 

echo You are not connected to the network. 

echo If you are outside the office then this is expected. 

echo If you are inside the office then it means there is a problem. 

echo Data stored on the network is not currently available. 

pause 

:end 

 

The file should be placed on the Desktop of the computer. After the computer starts up, the user should run it by 

double-clicking on its icon. A window is displayed prompting for the user name, followed by a prompt for the password: 

http://www.serverinstallationguides.co.uk/
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Figure 43: Enter user name and password 

After the user has successfully entered their details, the mapped drives will be available until the computer is shutdown 

or the user logs off. The drive mappings can be viewed by launching Windows Explorer/File Explorer, which appears 

by default on the Taskbar in Windows 7 and later versions: 

 

Figure 44: Display of mapped drives 

If the server is not available, rather than mapping the drives a warning message is displayed instead: 
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Figure 45: Warning message when not connected 

It is to be expected that this message will appear if using, say, a laptop computer outside of an office, but if it appears 

inside then it indicates a problem. This could be a connectivity issue on the computer e.g. Ethernet cable unplugged 

or wireless disabled. If everyone is experiencing problems then it would suggest that the server is powered off or 

otherwise out of action. 

When a particular user has finished with a computer, they should logoff or restart the computer. 

Ideally, computers should be setup with only one Windows user defined on them. If this is not the case, then the 

Connect-to-Server.cmd file needs to be placed on the Desktop for each individual user. More efficiently, it can be 

placed in the following location where it will appear on the Desktop for all users: 

Windows 10  C:\Users\Public\Public Desktop 

Windows 8.1/8  C:\Users\Public\Public Desktop 

Windows 7  C:\Users\Public\Public Desktop 

Windows Vista  C:\Users\Public\Public Desktop 

Windows XP  C:\Documents and Settings\All Users\Desktop 

 

Note that the Public Desktop folder is a hidden folder on Windows 10, 8, 7 and Vista and will therefore first need to 

be made visible before it can be used. To do this, go to Control Panel on the computer and choose Folder Options. 

Click on the View tab, enable Show hidden files, folders and drives and click OK: 



 

55 
 

 

Figure 46: Folder options to view hidden files 

Copy the Connect-to-Server.cmd file to the Public Desktop folder, then make the Public Desktop folder hidden again. 

Unfortunately, Connect-to-Server.cmd is not very tolerant of errors. If the user enters the wrong logon details there 

will be a brief error message and the drives will fail to map. The user will need to run the file and try again. 
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5.5 Connecting a Mac 

There are numerous iterations of the OS X operating system and some subtle differences between them. However, 

the following technique should work with all versions. If you encounter difficulties, make sure that the default 

workgroup name – which should be workgroup – has not been changed on the Mac (System Preferences > Network. 

Highlight the active network connection, click the Advanced button followed by WINS).   

On the menu bar of the Mac, click Go followed by Connect to Server. Alternatively, press Command K. A dialog box 

is displayed. Enter the name of the Windows 8.1 preceded with smb:// e.g. smb://server. To add the server to your 

list of Favorites for future reference click the + button. Then click Connect: 

 

Figure 47: Connect to server 

Enter a user name and password as previously defined on the server and click Connect. You can also tick the 

Remember this password in my keychain box if desired: 

 

Figure 48: Enter the user name and password 

A list of shared folders is displayed, referred to as volumes in Apple parlance. Choose the volume to mount and click 

OK. Note: to mount multiple volumes in one go, hold down the Command key and click on the required folders in 

turn: 
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Figure 49: Select the volume(s) to mount 

An icon for the volume will appear on the Desktop - click it to display the contents. It behaves like any standard OS X 

folder: 

 

Figure 50: Example of mounted folder 
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6 MULTIMEDIA & STREAMING 

One of the most popular uses of a home network is for the storage and playback of media such as music, videos and 

photos, which are held in a centralized library on the server. CDs and DVDs can be “ripped” into formats such as MP3 

and MP4 and these copies played back or streamed from the server, thus protecting the originals against wear and 

tear. They can then be accessed from other devices in the household including computers, gaming consoles, tablets, 

smartphones and streaming TV devices. 

6.1 Setup Streaming 

It is fair to say that getting streaming working is possibly more complicated than it needs to be and a number of steps 

are required. 

The first thing to do is copy your music, photos and videos onto the server. Music should be in MP3 format; most 

online services do or can provide it in this format, whereas Windows Media Player or iTunes can be used to convert 

existing audio CDs into MP3. Copy the music to the shared\music folder on the server. Video DVDs can be converted 

using tools such as DVDFab or Handbrake; generally speaking, keep things as simple as possible (e.g. MP4 with stereo 

sound) for best results. The resultant rips should be copies to the shared\videos folder. Note that the unauthorized 

copying of commercial CDs and DVDs is prohibited in most countries. 

Photographs and pictures should be copied to shared\pictures. These are usually in JPG/JPEG format, which is fine. 

Next, launch Windows Media Player. This can be found on the Windows 8.1 Start Screen – click on the downward-

pointing arrow to view all applications and it will be listed in the Windows Accessories section. On the menu within 

Windows Media Player, click Stream followed by Turn on media streaming. A panel from the Network and Sharing 

Center section within Control Panel will be displayed – click the Turn on media streaming button. The following panel 

is displayed; the defaults are all fine, but you may wish to give the media library a different name (it will be 

systemadmin – below we have changed it to homemedia). Click OK: 
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Figure 51: Configuring media streaming options 

Windows Media Player expects to find files in certain pre-defined locations. These locations make sense on a personal 

system, but not necessarily on a networked one so we need to make some changes. Within Windows Media Player, 

right-click on the entry for Music and choose Manage Music library. Click the Add button. Navigate to the shared 

folder, highlight the music sub-folder and click Include folder. 
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Figure 52: Specify location of the shared music folder 

This procedure should now be repeated for videos by adding shared\videos to it and for pictures by adding 

shared\pictures to it. 
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6.2 Playback Media on Other Devices 

It should now be possible to playback the shared media from other devices on the network. For instance, go to a 

computer and launch Windows Media Player on it. On the left-hand side of the screen, under ‘Other Libraries’, the 

server should now be visible. Click on a section i.e. Music, Videos or Pictures, to view what is available on the server. 

Double-click on a file to view/play/listen as appropriate: 

 

Figure 53: Accessing shared media 

As the media server in Windows 8.1 is DLNA-compliant – a sort of universal standard for such things – it is usually 

possible to access the server from other DLNA-compliant devices including Smart televisions and set-top boxes, Blu 

Ray players, mobile phones and more. Also, DLNA clients are available for the Apple iPhone and iPad from the App 

store. Note that Microsoft do not actually use the term DLNA in any of their software, using instead the term 

Plug’n’Play.  
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7 USING CLOUD STORAGE SERVICES 

Windows 8 has some rudimentary features to enable remote access and working, plus it is also possible to obtain third 

party products that can improve on them. However, a simple and popular method to provide remote access to data is 

by using a Cloud-based file sync service. These services can provide remote access to data in a simpler method with 

less effort and on a wider range of devices, plus provide controlled access to selected files for third parties via emailed 

links. They can also or alternatively be used as a way of backing up data from the server, providing offsite storage to 

complement the internal backup. Examples of popular file sync services include Dropbox and Google Drive.  

There are five main considerations when using a cloud file sync service with a Windows 8-based server: 

1. A single account has to be used for everyone. 

2. The account should have sufficient space. Some services only have a small amount of free space, for instance 

Dropbox only gives 2GB (plus any additional space gained through referrals). This is unlikely to be enough in a 

business environment so it may be necessary to consider a paid account. 

3. Whether it will be used for additional backups or as a means of providing remote access to data when out of 

the office. 

4. Who has access to it (if used for backups only, then only the server administrator needs access). 

5. Who will be responsible for managing it (usually the person who administers the server). 
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7.1 Dropbox 

Dropbox is a hugely popular service that works very well – client programs are available for PCs, Macs, iOS, Android 

tablets and phones and more. 

Begin by installing the Dropbox client on the server. This is best done by downloading it directly from the Dropbox 

home page. Immediately after installation, click the Advanced Settings option as this allows you to specify the location 

of the Dropbox folder. For the location, choose the Shared folder that we created in section 4 SHARED FOLDERS: 

 

Figure 54: Dropbox folder location on server 

To gain access, users should now install the Dropbox client on the devices they use outside of the office, downloadable 

from www.dropbox.com or from the Apple and Android app stores. To do so, they will need to know the common 

Dropbox account (login and password) details. At the time of writing, Dropbox is available for: Windows, Mac OS X, 

iPad & iPhone, Android, Windows Phone, Blackberry and selected Linux distributions.  

One thing to consider is what happens when people leave the organization, as if they have Dropbox installed on a 

home computer or phone or tablet they will continue to have access to whatever is stored on the server’s Dropbox 

folder. In such circumstances it will be necessary for the administrator to change the password of the Dropbox account 

and advise remaining staff of the new password. 

 



 

64 
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7.2 Google Drive 

Google Drive provides 15GB free storage; optional paid plans are available to increase this amount. Begin by going to 

the Google website and downloading and installing the Google Drive client on the server. When you reach Step 4 

pause and click on the Advanced setup button: 

 

Figure 55: Installing Google Drive 

This will display a panel where you can specify the location for Google Drive, which is necessary as the default location 

is unsuitable for our purposes. Click the Change button and navigate to the Shared folder that we created in section 4 

SHARED FOLDERS. Click Make new folder and create one called Google Drive within the Shared folder (it does not 

actually need to be called Google Drive but it is as good a name as any). Then click OK and Start Sync: 
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Figure 56: Specifying a folder for Google Drive 

To gain access, the permitted users should now install the Google Drive client on the devices they use outside of the 

office, downloadable from Google or the Apple and Android app stores. To do so, they will need to know the common 

Google account (login and password) details. At the time of writing, Dropbox is available for: Windows, Mac OS X, iPad 

& iPhone and Android.  

One thing to consider is what happens when people leave the organization, as if they have Google Drive installed on 

a home computer or phone or tablet they will continue to have access to whatever is stored on the server’s Google 

Drive folder. In such circumstances it will be necessary for the administrator to change the password of the Google 

account and advise remaining staff of the new password. 
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7.3 Box 

Box offers 10GB of free space with personal accounts, with paid subscriptions available for larger amounts of storage. 

The Box Sync client is available for many platforms including Windows, Mac OS X, iOS, Android, BlackBerry and 

Windows Phone. 

Begin by downloading and installing the Box Sync client for Windows. When it runs for the first time, click where it 

reads Customize Folder Settings at the bottom of the Welcome screen: 

 

Figure 57: Box Sync Welcome screen 

On the screen that appears click the Change button. Navigate through the resultant panel and choose the Shared 

folder (in this particular example it is located on the Storage Space E: drive) and click OK – this will cause the Box Sync 

folder to be created where all users can easily access it. Click Done and you will be returned to the initial Welcome 

screen, where you should click the blue Start Syncing button. 
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Figure 58: Choose location for Box Sync folder 

To gain access, the permitted users should now install the Box Sync client on the devices they use outside of the office, 

downloadable from the Box website or the various app stores. To install they will need to know the common Box 

account (login and password) details.   

One thing to consider is what happens when people leave the organization, as if they have Box Sync installed on a 

home computer or phone or tablet they will continue to have access to whatever is stored on the server’s Box folder. 

In such circumstances it will be necessary for the administrator to change the password of the Box account and advise 

remaining staff of the new password. 

7.4 Comments about OneDrive and iCloud 

OneDrive is Microsoft’s own file sync service. The OneDrive client is built-in to Windows 8.1 and, on the face of it, 

would seem to be an ideal choice; however, the tight integration between OneDrive and Windows 8.1 can also be 

considered a disadvantage. The reason for this is that OneDrive requires a Microsoft ID, which also becomes the main 

user login name for the computer. When we installed Windows 8.1 we specifically chose to use a local ID 

(systemadmin) - if a Microsoft ID is used it will be necessary to always run the server logged using it. Additionally, it 

will be necessary to provide these login details for the server to the users. In a household this may or not be an issue, 

but it is not recommended in a business environment due to the risk of the server being compromised. For this reason, 

the use of OneDrive in this scenario is not recommended.  

iCloud is Apple’s file sync service. Many people, even if ardent Windows users, will have an iPad or iPhone and hence 

an Apple ID and iCloud access and may be interested in using their space on the server. Although the Windows client 
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works on Windows 8.1, it is difficult to relocate the iCloud folder from its default location to somewhere more suitable 

i.e. the shared folder. For this reason it is suggested that iCloud is not used.  
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8 USING IPADS AND OTHER PORTABLE DEVICES 

Most portable devices such as iPads, iPhones and Android tablets and cell phones are not able to directly connect to 

networks in the sense that Windows PCs or Macs can. However, this does not mean that they cannot access data and 

be used in a productive manner. A variety of apps and techniques are available to both access data and administer the 

server and some of the main ones are discussed below. 

8.1 Accessing the File System with File Browser 

For iOS users, File Browser from Stratospherix is a good way of accessing folders and files on the server. It is a 

commercial product obtainable from the App Store, but is inexpensive and well worth buying. It is not specifically 

designed for accessing Windows computers, rather it is a generic tool for accessing any networked computer. To use, 

enter the name of the server (i.e. “server” in our case) along with a valid user name and password; the user can then 

see any of the folders to which they have been granted access (for example, the shared folder). To access their home 

folder, double-click the Homes folder then double-click the folder that has the same name as their own user name. 

Note that they can see the names of other people’s home folders, but will not be able to access them because of 

security restrictions. Files can be viewed, but not edited, and many media types played. 

 

Figure 59: File Browser from Stratospherix running on iPad 
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8.2 Using a Cloud Sync Service 

Cloud sync services such as Dropbox, Google Drive and Box provide a means of remotely accessing data on the server. 

They have a number of advantages: they are available on a wide range of portable devices including those running 

iOS, Android, Windows Phone and Blackberry. Secondly, they require minimal knowledge to get them up and running 

on the client devices. Thirdly, they are free (or rather can be, depending on the amount of storage the organization 

requires). The installation of Dropbox, Google Drive and Box is covered more comprehensively in 7 USING CLOUD 

STORAGE SERVICES. 

8.3 Multimedia Playback 

If streaming has been enabled on the server (see 6 MULTIMEDIA & STREAMING) then music, photos and videos can 

be played back on portable devices such as tablets and mobile phones. To do this, the portable device needs to be 

DLNA-compliant. Some already are, else, for instance in the case of iOS devices, a DLNA client can be downloaded 

from the App store. 

8.4 Microsoft Remote Desktop app for iOS 

Microsoft have an official app for iOS that enables a Windows computer to be accessed remotely. It is basically an RDP 

client and can be downloaded free of charge from the App Store. On the Windows 8 server make sure that Remote 

Desktop is enabled (go into Control Panel > System > Remote Settings. Click the Remote tab; in the Remote Desktop 

section make sure that the only option enabled is Allow remote connections to this computer. On the iPad or iPhone 

run the app and enter the name of the server plus the user details for systemadmin.  

Whilst working on a small screen with no keyboard imposes some restrictions, Microsoft have done a good job with 

this tool. To improve usability, the Remote Desktop app has a virtual keyboard and a screen zoom facility. Pressing 

down with a finger for a couple of seconds is equivalent to a right-hand button mouse click, which is very useful. 
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Figure 60: Microsoft Remote Desktop app running on iPad 
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8.5 Chromebooks 

Chromebooks are an increasingly popular computing choice for many people. In essence a Chromebook is a laptop 

that only runs a browser; the underlying operating system is very minimalist compared to Windows and this means it 

does not currently understand networks and servers. As such it is only possible to do things that can be done within a 

browser, however, this still gives some possibilities. For instance, a Chromebook can be used to remotely administer 

the server. To do so requires RDP client software. There are several examples available, but one that works quite well 

is Chrome RDP from Fusionlabs.net. This is available from the Chrome Store; it is a commercial application but the 

license is only US $9.99 (a 7 day trial version is available for those who want to try-before-they-buy). 

If a Cloud-based file sync service such as Dropbox, Google Drive or Box is being used with the server, then it will be 

possible to access the data from the Chromebook by logging in to the appropriate website. Of these services, Google 

Drive is probably the most useful because of the tight integration with Chrome and the ability to edit files using Google 

Docs. 
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9 BACKUPS 

9.1 Backing up the Server 

Servers have to be backed up on a regular basis so that data can be recovered in the event of loss or other problems. 

The easiest and most common method is to use a dedicated backup program in conjunction with a plug-in external 

USB hard drive. Windows 8.1 features a built-in backup program known as File History which, on the face of it, would 

appear to be the obvious choice. However, File History has a number of limitations which restrict its usefulness when 

Windows 8 is being used as a server. Most crucially, it does not understand the normal concept of drives and folders, 

being based instead around the concept of Libraries. Adding specific folders or Storage Spaces to the default Windows 

8 Library so they can be backed up is an inflexible and unintuitive process and for this reason the use of a more 

conventional, third party program is suggested. There any many to choose from; the one we will use here is FBackup 

from Softland, which is totally free both for commercial as well as private use (see www.fbackup.com). When 

downloading it, take care not to download any additional unrequired programs such as toolbars and other utilities. 

The USB drive used for the backups should be at least equal in capacity to the total amount of storage in the server 

e.g. if the server has 2TB disc storage then the backup drive should be at least 2TB as well. Preferably it should be a 

USB 3.0 drive, as the performance is much better than with USB 2.0. Most newly purchased USB drives will come 

ready-to-use and preformatted as NTFS, but if an existing drive is being reutilised you may wish to format it. To do so, 

right-click the Start button and choose Disk Management. Find the USB drive in the panel that appears, right-click it 

and choose Format. The default values are fine in most circumstances, although you may want to give the drive a 

meaningful Volume Name, such as backup. 

Launch FBackup and click the New icon to define a new backup task. Give it a meaningful name (e.g. CompleteBackup). 

Specify the destination for the backup – in this example we have an F: drive called Backup. Click Next:   

 

http://www.fbackup.com/
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Figure 61: Specifying backup parameters 

On the subsequent screen choose the folder(s) or drive(s) to be backed up by clicking the Add folder button. In our 

example we are backing up the Storage Space volume E: 

 

Figure 62: Choosing folder(s) to be backed up 

Click OK and Next. The next screen is for specifying the type of backup and the choices are Make full or Make mirror. 

Choose the latter as this stores the backup in a standard file format that can be read with Windows File Explorer. It is 

not necessary to encrypt the backup unless there are specific security requirements. Click Next. 
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Figure 63: Encryption option 

The subsequent screen allows the backup to be scheduled to run on an automatic basis. In most scenarios a daily 

backup is suitable, but it can be more or less frequent as required. Schedule the backup to run at a time when the 

server is not normally busy as it can impact performance, for instance at the end of day or overnight. In this example 

the backup runs daily at 6:00pm.  
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Figure 64: Specify the backup schedule 

Having specified the schedule click the Save button. There is a choice of just Save or Save and Run; the latter option is 

useful as it will cause the newly created backup job to run immediately, constituting a useful test and first backup. 

When the backup is complete a logfile and message are generated – on subsequent occasions these should be checked 

to confirm that the scheduled backups are working. 

FBackup is a good backup program that works well. If additional features are required – for instance, the ability to 

backup to cloud services such as Amazon S3 or Microsoft Azure and advanced encryption capabilities – these are 

available in a paid for product called Backup4all Pro from the same company. 
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9.2 Restoring Data to the Server 

If a file or folder is lost (for instance, a user has accidentally deleted it) or it is required to revert to an earlier version, 

then it can be restored using FBackup. Launch the program and click the Restore icon to start the Restore Wizard. 

There are several options but in this example a folder has been deleted and needs to be put back. Click Use original 

location and Choose files and restore the latest version: 

 

Figure 65: Restore Wizard 

Click Next. On the following panel choose the file(s) or folder(s) to be restored then click Finish (in this example we 

are restoring the Pictures folder on Shared): 
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Figure 66: Choose the files/folders to be restored 
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9.3 Backing up PCs to the Server 

If users store data on their computers rather than on the network, then there is probably a requirement to be able to 

backup that data. This can be done using the built-in backup programs in Windows 7 and Windows 8 clients, with the 

actual backups stored on the server. As the server itself is being backed up, this will ensure multiple copies of the data, 

hopefully enough to cope with any eventuality.  

9.4 Backing up Windows 7 Computers to the Server 

Click Start, followed by All Programs, Maintenance then Backup and Restore. Click on Set up Backup: 

 

Figure 67: Select destination for backup 

Click the Save on a network button. On the next panel, enter the Network Location. Specify the user’s home folder, 

using the format \\server\homes\username (or click the Browse button to navigate to it). You may be prompted to 

login - enter the user name and password as defined on the server then click OK: 
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Figure 68: Enter network details 

The subsequent screen is for choosing what data files are backed up. The default option of Let Windows choose 

(recommended) is fine in most cases so just click Next: 
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Figure 69: Choose the items to backup 

The follow-on screen is a summary of settings; click Save settings and run backup: 
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Figure 70: Review backup settings 

The backup will then run for the first time, during which the status is displayed. By default Windows has defined a 

schedule to subsequently run backups automatically on a regular basis (in this case, every Sunday at 7:00pm). If this 

setting is not suitable it can be changed by clicking Change settings. 
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Figure 71: Backup in progress 
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9.5 Backing up Windows 8/8.1 Computers to the Server 

Begin by mapping the user’s home drive on the network drive using one of the techniques described in section 5 

ACCESSING THE SERVER. Then go into the Control Panel and click File History (remember that in Windows 8.1 you can 

right-click the Start button to locate the Control Panel): 

 

Figure 72: Initial screen in File History 

Click Select a network location. On the screen that is displayed click Show all network locations. From the list, choose 

the user’s home folder and click Verify your credentials. Enter the user name and password as defined on the server 

if prompted; if the computer is only ever used by one person you can tick the Remember my credentials box: 
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Figure 73: Specify network credentials 

Click OK to return to the initial File History screen and click the Turn on button. After a few seconds, the backup will 

run for the first time. Thereafter, it can be run at any point by clicking Run now.  

For greater control over the process, such as controlling the frequency at which the backup runs, click Advanced 

settings: 
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 Figure 74: File History Advanced settings 
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9.6 Backing up Windows 10 Computers to the Server 

Begin by mapping the user’s home drive on the network drive using one of the techniques described in section 5 

ACCESSING THE SERVER (if not already mapped). Then click Start > Settings > Update & security > Backup. Click Add 

a drive and after a few seconds the list of mapped drives will be displayed – click on the user’s home drive: 

 

Figure 75: Specify the home folder as the backup drive 

Having done so you will be returned to the main Backup panel, where an option to Automatically back up my files will 

have appeared and been set to On. That’s it – a backup will now run on an hourly basis, copying the user’s files from 

the computer to their home drive on the server. 

For greater control over the process, such as controlling the frequency at which the backup runs, click More options. 

From here you can: review the backup status; make the backup run immediately; achange the backup frequency 

(anything from every 10 minutes through to 1 day); change the retention period for the backed-up data:  
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 Figure 76: Additional backup options 
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10 HOUSEKEEPING AND MONITORING THE HEALTH OF THE SERVER 

Servers need to be checked on a regular basis to ensure that there are no problems and that they are in good health. 

Clearly some type of problems will be immediately apparent, for example if the server is powered down for whatever 

reason then nobody will be able to use it. But there are plenty of other things that need to be monitored; for instance: 

Has the backup completed successfully? Is the server running out of storage space? Additionally, there are some 

housekeeping tasks that need to be carried out on an occasional basis. This section also include some ideas for making 

the server more convenient to work with for the person who administers it. 

10.1 Applying Windows Updates 

It is important to check for and apply the updates to Windows Server that Microsoft makes available on a regular basis. 

Such updates may provide improved or additional functionality, but more typically address security issues that could 

compromise the system. On regular desktop and laptop computers, Windows updates are often applied automatically; 

however, it is suggested that automatic Windows updates are not enabled on servers. The reason for this is to ensure 

total control over the process and stop the risk of the server rebooting on its own accord following an update. Also, it 

is suggested that updating is done out of hours so as to avoid any disruption to service, perhaps on a monthly basis. 

Go into Control Panel. If it is currently set to view by Category, change it to view by Large Icons. Click the Windows 

Update icon followed by the Turn on Automatic updates button, which will force the system to check for updates. 

After a couple of minutes the screen will refresh and display a message that “nn important updates are available” 

(where nn is the number of such updates). Click the message and on the next screen click the Install button at the 

bottom of the screen. The updates will download and install; this may take some time and may necessitate the server 

having to restart to complete the process. 

Once the server is up-to-date, go back into Windows Update and click Change Settings. Set it to a value other than 

‘Install updates automatically’ and click OK.  
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Figure 77: Windows Update settings 
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10.2 Check Disk Space 

The amount of free space on the hard drive(s) should be checked on a regular basis, which can be done by simply going 

into File Explorer. If the amount of free space drops below 25% then housekeeping should be performed to free up 

more space, for instance by deleting old and unwanted files and/or archiving them to a separate drive. If the server is 

persistently short of space then consider adding more storage. If Storage Spaces are being used - see section 2.10 

Storage Spaces (System with Multiple Drives) - then another drive can be added to the Storage Pool. 

10.3 Optimizing the Hard Drives 

The hard drives on a computer should be optimized (also known as defragmented) on a regular basis to reduce file 

fragmentation and maximise performance. With Windows 8.1 this takes place automatically on a weekly basis. To 

verify that it is configured correctly and operating, open File Explorer, right-click on any drive, click Properties then 

Tools followed by Optimize to show the following panel: 

 

Figure 78: Optimize the hard drives 

Towards the bottom left-hand corner it should read that Scheduled optimization is ‘On’ and that the drives are being 

optimized automatically on a weekly frequency. If this is not the case, click the Change settings button and adjust the 

settings accordingly. 

Important: if the server includes any Solid State Drives (SSDs) then they should never be optimized – it is not necessary 

and will shorten their lifespan. Windows 8.1 should have automatically detected them but if it has not then turn off 

scheduled optimization and optimize any conventional hard drives on a manual basis every couple of weeks. This can 

be done using the panel displayed above: highlight the drive, click Analyze to determine its status then click Optimize 

if necessary. 
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10.4 Checking the Event Viewer 

Windows 8.1 maintains comprehensive records of the myriad events that take place during the operation of the 

computer. Some of these are simply records of normal usage whereas others are generated in response to specific 

errors and can be used to help diagnose problems. The events are categorised into several main types and recorded 

in log files, which should be specifically checked in the event of problems and otherwise on an occasional basis. 

However, note that diagnosing such problems is a relatively advanced topic. 

To access the Event Logs, right-click the Start button and choose Event Viewer. A screen along the following lines is 

displayed (note that it may take some seconds to fully populate): 

 

 Figure 79: The Event Viewer 

Some of the event logs are more useful than others. In the left-hand panel, expand the tree to display the Windows 

Logs section. There are five separate logs: Application, Security, Setup, System and Forwarded Events. To view a 

particular log, click on it. Each event is categorized as an Error, a Warning or Information, along with a timestamp plus 

a short description. The listing can be sorted by clicking on the heading for a column: 
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Figure 80: Example of an Event log 

For most purposes the System and Application logs contain the most useful information. If a server crashes or freezes 

– which is a very rare occurrence – there may well be clues in the System log. If there are suspected security violations 

then the Security log may contain details. However, note that the Security log is very “noisy” and may generate 

thousands of events every hour, making it difficult to sort out the important entries. 

The Event logs will eventually overwrite when they are full. If required, they can be archived as permanent records or 

to preserve evidence. To do so, right-click on an Event Log and from the pop-up menu choose Clear Log. A message is 

displayed offering three choices – click the Save and Clear button. In the resultant dialog box specify a name for the 

file: a good choice is its name plus the date e.g. setup-12092015.  
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10.5 Anti-Virus & Anti-Malware Software 

As with any computer, the server is susceptible to viruses and malware and for this reason an anti-virus program 

should be used. Fortunately, Windows 8.1 includes a credible built-in and free anti-virus program in the form of 

Windows Defender (previously known as Windows Security Essentials) and this is usually sufficient for most people. It 

is not necessary to use or purchase a separate anti-virus program, although this remains an option for those who 

prefer it (some people think a paid program is automatically better than a free one although there is no evidence to 

support this). If you are using a computer that was supplied with a third party anti-virus, perhaps in the form of a 

limited trial version, you should remove it and make sure that Windows Defender has been restored. To check the 

status of Windows Defender, go into the Control Panel and click the Windows Defender icon.  

Also consider using Malwarebytes, a highly regarded piece of software for protecting against and cleaning up malware 

on computers. It will often sort out the ‘nasties’ that even the best anti-virus software misses, providing a valuable 

second line of defence. It is available in both free and paid versions; the paid version is very low cost and has the 

advantage that scans can be scheduled to take place automatically, as opposed to run manually. It is best obtained by 

downloading from the www.malwarebytes.org website.   

 

Figure 81: Main Malwarebytes scan screen 
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10.6 Remote Desktop 

Note: this section is only applicable if you are using Windows 8.1 Professional edition or better. 

When setting up the server a standard monitor, keyboard and mouse need to be used. However, once the server is up 

and running these can be dispensed with and it can be run in so-called headless mode. To access it for support 

purposes, the Remote Desktop capability of Windows is used. This has several advantages: firstly, the server can be 

accessed from any computer on the network and it is not necessary to have physical access to the server, which may 

be a consideration if it is situated in a secure, locked or otherwise inaccessible location. Secondly, dispensing with a 

physical screen, keyboard and mouse saves space (and possibly a small amount of electrical power). Thirdly, in some 

small organizations the server may have to be physically located in a general purpose office; not having a keyboard 

and screen will reduce the temptation for staff to treat it as just another computer.  

During installation, Windows 8.1 should have automatically enabled Remote Desktop. This can be verified (or if 

necessary, corrected) by going into Control Panel and clicking the System icon. Click Remote Settings and the Remote 

tab of System Properties will be displayed. Make sure that the Allow remote connections to this computer and Allow 

connections only from computers running Remote Desktop with Network Level Authentication options are enabled. 

It is not necessary to use the Select Users button. Click OK. 

 

Figure 82: Enabling remote connections on the server 

Test the facility by going to a computer on the network and launching the Remote Desktop Connection program, which 

is a standard part of Windows (located in Start > All Programs > Accessories). Enter the name of the server (i.e. 

“server”) and logon as systemadmin. A warning message along the following lines may be displayed – it can safely be 

ignored. Once everything has been tested, the physical screen, keyboard and mouse of the server can be dispensed 

with. 
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Figure 83: Certificate warning message from Remote Desktop 
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11 ACCESSING THE SERVER REMOTELY 

Note: this facility requires the use of Windows 8.1 Professional edition or better. 

The Remote Desktop facility described in 10.6 Remote Desktop can also be used to access the server truly remotely 

i.e. from anywhere in the world, using the internet. This is very useful in a small business environment as the person 

responsible for looking after the server may not be permanently located in the office, or there may be a need to do 

support out-of-hours. To set this up it is necessary to first change the server to use a fixed IP address internally, 

configure a feature called port forwarding on your internet router, plus obtain a Dynamic DNS (DDNS) name. Note: 

this topic requires some technical knowledge. 

11.1 Fixed IP Address 

Every device within a network has a number to uniquely identify it, known as the IP address. The router itself will have 

a default fixed IP address decided by the manufacturer, for instance 192.168.1.1 is a common choice. It will then 

allocate numbers to computers and devices as they connect, for example the first computer might become 

192.168.1.101, the second computer might become 192.168.1.102 and so on. A piece of software inside the router – 

known as a DHCP server – handles this process. The ‘D’ in DHCP stands for dynamic and indicates that the IP addresses 

are handled dynamically and recycled. So, for example, the next time the first computer is switched on it might be 

allocated a different number, say 192.168.1.108. The fact that the numbers change does not make any difference to 

computers but some devices prefer a fixed address, which is why routers have them. During normal usage the server 

will have received an IP address from the router’s DHCP server. However, to use it remotely we need to change it to a 

fixed IP address.   

Right-click the Start button and choose Network Connections. Right-click the network adapter and choose Properties. 

Highlight Internet Protocol Version 4 (TCP/IPv4) and click Properties. Change it to use a specific IP address. The 

address depends upon how the router is configured; typically they use a 198.168.nnn.nnn addressing scheme with the 

router itself on, say, 192.168.1.1 or 192.168.1.254. The server should be given a nearby address. You may have to refer 

to the router manufacturers documentation for its address but some common ones include: TalkTalk 192.168.1.1; 

Belkin 192.168.2.1; Buffalo 192.168.11.1; D-Link 192.168.0.1; BT 192.168.1.254; Billion 192.168.1.254; Linksys 

192.168.1.1; Netgear 192.168.0.1; Apple 10.0.1.1. Another method to determine the IP address of the router on a 

Windows PC is as follows: 

Right-click the Start button then choose Run. Alternatively, hold down the Windows key and press the letter R. In the 

small dialog box that appears, type in cmd and press Enter. In the black box that appears type ipconfig and hit Enter. 

Look for the entry that reads Default Gateway, which is another name for router.  

In this example, the router is 192.168.1.1 so the server is being set to 192.168.1.2. The Default gateway is the address 

of the router; the subnet mask should be 255.255.255.0 and the Preferred DNS server set to the address of the router: 



 

99 
 

 

Figure 84: Specify the IP address 

Make the change, click OK and Close. Restart the server. If any computers were connected to the server whilst you 

were doing this then they will probably have lost the connection and may need to be restarted themselves. 

11.2 Port Forwarding 

Port Forwarding is a technique that enables internet “traffic” to be directed at a particular device within a network. 

The internet is most commonly used for accessing web sites but is also used for many different types of traffic or 

protocols, such as Skype, email, FTP and so on. Each of these protocols has a particular number associated with it and 

in the case of remote desktop it is called RDP and has a (port) number of 3389. So, from a technical perspective the 

requirement is to forward port 3389 to the internal IP address of the Windows 8 server e.g. 192.168.1.2. 

How to actually do this varies according to the individual router. In most cases it consists of: entering the internal IP 

address of the router (e.g. 192.168.1.1) into a browser; logging in as the admin user; finding the section concerned 

with port forwarding (which may in an ‘Advanced section’) and specifying that port 3389 should be forwarded to the 

server (192.168.1.2 in our example). There are a few exceptions to this; for instance, Apple AirPort routers are 

configured using the AirPort app that is available for Mac OS X and iOS. Refer to the instruction manual supplied by 

the manufacturer. Alternatively, instructions for configuring most popular routers can be found at the 

www.portforward.com website. 

11.3 Dynamic DNS (DDNS) 

It is easy to find a website on the internet – you simply enter its name e.g. www.ctacs.co.uk, www.microsoft.com or 

whatever you are interested in. But what is the name (“hostname”) of your Windows 8 server on the internet? The 

answer is: it doesn’t have one - it just has a number in the form of an external IP address provided by your ISP (internet 

service provider) and you need to know what this IP address is in order to access the server. To find out what your 

external IP address is go to a website such as www.whatismyipaddress.com. If you now enter this address into the 
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Remote Desktop Connection software as described in section 11.4 Using the Remote Desktop Client you will be able 

to connect to the server. 

However, there is a potential problem. In the same way that internal IP addresses can be fixed or dynamic, so can 

external IP addresses. Fixed IP addresses – usually called static IP addresses – are preferable as by definition they do 

not change and if you have or can obtain one from your ISP then you are home and dry. However, most ISPs, 

particularly those in the home or small business markets, usually provide a dynamic IP address. As such, your external 

address can change at any time. In fairness, with some ISPs the dynamic addresses are “sticky”, in that they only usually 

change when the router is rebooted. In such cases, you may well have the same IP address for months on end; it might 

be an inconvenience when it does change, but if it’s only a few times a year you might be able to live with it. But what 

if you cannot? 

The answer to this is something called Dynamic Domain Naming System or DDNS (Dynamic DNS). DDNS services give 

you a unique name on the internet and automatically update what goes on behind the scenes when the underlying IP 

address changes.  Numerous organisations provide DDNS services, some on a free basis and others on a commercial 

basis. Examples of suppliers include No-IP, DynDNS and FreeDNS. Most routers are able to work with DDNS – the 

account details have to be entered into them – although some will only work with a limited number of DDNS providers, 

fortunately the most popular ones. How to actually do this varies according to the individual router. In most cases it 

consists of entering the internal IP address of the router (e.g. 192.168.1.1) into a browser, logging in as the admin user 

and finding the section concerned with DDNS. The terminology can vary – the section may be called ‘DDNS’, 

‘Hostname’ or ‘Dynamic Global Hostname’ 

11.4 Using the Remote Desktop Client 

Once everything has been configured you can test the remote access facility – it is best to do this from outside the 

home or office using a different internet connection. Launch the Remote Desktop Connection program, which is a 

standard part of Windows (located in Start > All Programs > Accessories). Enter the external IP address of the service, 

or the hostname if you have setup a DDNS account. Logon as systemadmin. A warning message along the following 

lines may be displayed – it can safely be ignored: 

 

Figure 85: Certificate warning message from Remote Desktop 
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At this point you can use the server in much the same way as if you were sitting in front of it, although the quality of 

the experience will be depend upon the speed of the internet connection at each end. 
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Thank you! 

 

We hope that you have found this guide helpful and interesting. Supplementary and supporting information can be 

found at the following website: www.serverinstallationguides.co.uk 

If you have any suggestions or have found areas for improvement, please let us know at enquiry@ctacs.co.uk 
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